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ABSTRACT 

Electricity theft is a major concern for the utilities. Many times power theft has been major impact on the 

economy as well as the development of the country. At present to monitor the various parameters like power 

consumption, the amount of load and to prevent electricity siphoning, an intelligent device would come handy to 

solve the problem for the power company and the clients. Application of techniques of power monitoring allows 

to power monitoring systems to receive the information remotely and in relation to the coordinates and time. In 

this project we are using smart power meter which are fitted on both at the transmission and load side. These 

meters are capable of measuring power sent over the load sand power consumed by the load over the time 

respectively. Both the parameters are sent to the base station wirelessly. Whenever there is a mismatch above the 

tolerance level parameters, then power theft is detected. The system will trigger the alarm to intimate to the 

concern authority so that they take necessary legal action and prevent power theft in the future. 

 

INTRODUCTION 

Application of techniques of power monitoring allows to power monitoring systems to receive the information 

remotely and in relation to the coordinates and time. In this project we are using smart power meter which are 

fitted on both at the transmission and load side. These meters are capable of measuring power sent over the load 

sand power consumed by the load over the time respectively. Both the parameters are sent to the base station 

wirelessly. Whenever there is a mismatch above the tolerance level parameters, then power theft is detected. The 

system will trigger the alarm to intimate to the concern authority so that they take necessary legal action and 

prevent power theft in the future.Power theft is the biggest problem now days, which causes huge loss to 

electricity boards. And to cover these losses ultimately, price are increased. So if we can prevent these thefts, we 

can save lot of power. By keeping track of electricity used, you determine where the greatest opportunity for 

energy savings lies. Becoming aware of overall energy use involves keeping track of the readings on the 

readings on the electric meter. The normal practice for power theft is to tag the wires to feeder lines for field 

motors power/etc. So by sensing current flow through the line & energy feedback we can prevent it using a 

circuit breaker.In this system, a micro controller is interfaced with a power lines/feeder lines with current sensors 

using simple current sensing circuit, RF communication link, & a contactor to make or break power line. At the 

sub-station end, a pc is connected with a RF link to communicate with all energy meters & a buzzer In normal 

condition, micro controller reads current value/ratio in feeder lines continuously. If the microcontroller gets both 

current transformer values same means there is no power theft occur, whenever the person is trying to theft the 

power this system automatically detect the condition  by changing the  CT(current transformer) this system 

automatically gives alarm system and send message to substation with area code. This information is sent to 

substation using wireless communication In the substation, it receives the information in the form of digital 

codes & on decoding it, we can know at which house power theft occurred 

 

LITERATURE SURVEY  

There are two types of power losses, technical losses and non-technical losses. Technical losses are naturally 

occurring losses due to power dissipation, for example I2R and copper losses. Non – technical losses are due to 

Mukt Shabd Journal

Volume XI, Issue II, FEBRUARY/2022

ISSN NO : 2347-3150

Page No : 757



component break down and electricity theft. Component break down is due to environmental factors and weather 

conditions such as heavy rains. In [1] the power theft practices are meter tampering, illegal connection, billing 

irregularities and unpaid bills. There have been various discussions on how to detect and prevent the power theft. 

[2] Proposes a system design which incorporates an android application and also indicates the exact zone on 

which unauthorized taping is done in the real time. It would provide a digital record in case of any judicial 

dispute current. If the line current is greater than the meter then an alert message is sent to the concerned 

authority with the help of GSM System. 

EXISTING SYSTEM 

There are many methods which have been proposed for theft detection. Many of these methods include 

load profile analysis of customers to detect abnormal energy consumption patterns. But these methods cannot be 

used to detect energy thefts when there is a complete bypass of electricity meters. In such cases, electricity losses 

are calculated by using energy balance between the energy supplied from the distribution transformer and the 

energy consumed at the consumer’s end. An effective way for estimating nontechnical losses in the electricity 

distribution network is correctly estimating the technical losses in the network and then subtracting it from the 

total loss in the network. 

DISADVANTAGES 

 Practical Implementation Issues. 

 Lower Detection Level. 

 Easily tamper able. 

 Complex Implementation. 

 

PROPOSED SYSTEM 

Our proposed approach deals with the tampering detection system for electric meters. Once the meter starts if 

any tampering is done the report will be immediately sent to the highest official and police station to take further 

access with consumer name, address, consumer id etc. We use Wi-Fi to send SMS and At mega Microcontroller 

for logic analysis. The programming language used is Embedded C. If someone tries to damage the seal or 

bypass the meter then meter orientation changes and tampering is detected. This will be reported to officials in 

terms of SMS to any number of users. Overall Functionality will display in LCD display. This is 100% 

practically implementable in real-time. 

ADVANTAGES  

 Real-time Implementation is Possible  

 Lesser Complex Design  

 High Accuracy  

 Lower Cost 
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BLOCK DIAGRAM 

 

 

EMBEDDED SYSTEMS 

Many embedded systems have substantially different design constraints than desktop computing applications. 

No single characterization applies to the diverse spectrum of embedded systems. However, 

cost pressure, long life-cycle, real-time requirements, reliability requirements, and design culture dysfunction 

can make it difficult to be successful applying traditional computer design methodologies and tools to embedded 

applications. Embedded systems in many cases must be optimizedfor life

rather than for maximum computing throughput. There is currently little 

computer design to the scope of holistic embedded sys

weaknesses of current approaches can set expectations appropriately, identify risk areas to tool adopters, and 

suggest ways in which tool builders can meet industrial needs. If we look around us, today we see 

appliances which we use daily, be it our refrigerator, the microwave oven, cars, PDAs etc. Most appliances   

today are powered by something beneath the sheath that makes them do what they do. These are tiny 

microprocessors, which respond to variou

assembly languages, are the heart of the appliances. We call them embedded systems. Of all the semiconductor 

industries, the embedded systems market place is the most conservative, and en

lean towards established, low risk solutions. Welcome to the world of embedded systems, of computers that will 

not look like computers and won’t function like anything we are familiar with.

CLASSIFICATION 

 

 Embedded systems are divided into autonomous, realtime, networked & mobile categories.

 Autonomous systems

 They function in standalone mode. Many embedded systems used for process control in manufacturing 

units& automobiles fall under this category.

Real-time embedded systems 

  These are required to carry out specific tasks in a specified amount of time. These systems are extensively 

used to carry out time critical tasks in process control.

Many embedded systems have substantially different design constraints than desktop computing applications. 

No single characterization applies to the diverse spectrum of embedded systems. However, 

time requirements, reliability requirements, and design culture dysfunction 

can make it difficult to be successful applying traditional computer design methodologies and tools to embedded 

ns. Embedded systems in many cases must be optimizedfor life-cycle and business

rather than for maximum computing throughput. There is currently little tool support for expanding embedded 

computer design to the scope of holistic embedded system design. However, knowing the strengths and 

weaknesses of current approaches can set expectations appropriately, identify risk areas to tool adopters, and 

suggest ways in which tool builders can meet industrial needs. If we look around us, today we see 

appliances which we use daily, be it our refrigerator, the microwave oven, cars, PDAs etc. Most appliances   

today are powered by something beneath the sheath that makes them do what they do. These are tiny 

microprocessors, which respond to various keystrokes or inputs. These tiny microprocessors, working on basic 

assembly languages, are the heart of the appliances. We call them embedded systems. Of all the semiconductor 

industries, the embedded systems market place is the most conservative, and engineering decisions here usually 

lean towards established, low risk solutions. Welcome to the world of embedded systems, of computers that will 

not look like computers and won’t function like anything we are familiar with. 

are divided into autonomous, realtime, networked & mobile categories.

They function in standalone mode. Many embedded systems used for process control in manufacturing 

units& automobiles fall under this category. 

These are required to carry out specific tasks in a specified amount of time. These systems are extensively 

used to carry out time critical tasks in process control. 

 

Many embedded systems have substantially different design constraints than desktop computing applications. 

No single characterization applies to the diverse spectrum of embedded systems. However, some combination of 

time requirements, reliability requirements, and design culture dysfunction 

can make it difficult to be successful applying traditional computer design methodologies and tools to embedded 

cycle and business-driven factors 

support for expanding embedded 

tem design. However, knowing the strengths and 

weaknesses of current approaches can set expectations appropriately, identify risk areas to tool adopters, and 

suggest ways in which tool builders can meet industrial needs. If we look around us, today we see numerous 

appliances which we use daily, be it our refrigerator, the microwave oven, cars, PDAs etc. Most appliances   

today are powered by something beneath the sheath that makes them do what they do. These are tiny 

s keystrokes or inputs. These tiny microprocessors, working on basic 

assembly languages, are the heart of the appliances. We call them embedded systems. Of all the semiconductor 

gineering decisions here usually 

lean towards established, low risk solutions. Welcome to the world of embedded systems, of computers that will 

are divided into autonomous, realtime, networked & mobile categories. 

They function in standalone mode. Many embedded systems used for process control in manufacturing 

These are required to carry out specific tasks in a specified amount of time. These systems are extensively 
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Networked embedded systems 

  They monitor plant parameters such as temperature, pressure and humidity and send the data over the 

network to a centralized system for on line monitoring. 

Mobile gadgets 

  Mobile gadgets need to store databases locally in their memory. These gadgets imbibe powerful 

computing & communication capabilities to perform realtime as well as nonrealtime tasks and handle 

multimedia applications. The embedded system is a combination of computer hardware, software, firmware and 

perhaps additional mechanical parts, designed to perform a specific function. A good example is an automatic 

washing machine or a microwave oven.  Such a system is in direct contrast to a personal computer, which is not 

designed to do only a specific task. But an embedded system is designed to do a specific task with in a given 

timeframe, repeatedly, endlessly, with or without human interaction. 

Hardware 

   Good software design in embedded systems stems from a good understanding of the hardware behind it. 

All embedded systems need a microprocessor, and the kinds of microprocessors used in them are quite varied. A 

list of some of the common microprocessors families are: ARM family, The Zilog Z8 family, Intel 8051/X86 

family, Motorola 68K family and the power PC family. For processing of information and execution of 

programs, embedded system incorporates microprocessor or micro- controller.  In an embedded system the 

microprocessor is a part of final product and is not available for reprogramming to the end user. An embedded 

system also needs memory for two purposes, to store its program and to store its data. Unlike normal desktops in 

which data and programs are stored at the same place, embedded systems store data and programs in different 

memories. This is simply because the embedded system does not have a hard drive and the program must be 

stored in memory even when the power is turned off. This type of memory is called ROM. Embedded 

applications commonly employ a special type of ROM that can be programmed or reprogrammed with the help 

of   special 

 

LCD (Liquid Cristal Display) 

Introduction: 

 A liquid crystal display (LCD) is a thin, flat display device made up of any number of color or 

monochrome pixels arrayed in front of a light source or reflector.  Each pixel consists of a column of liquid 

crystal molecules suspended between two transparent electrodes, and two polarizing filters, the axes of polarity 

of which are perpendicular to each other.  Without the liquid crystals between them, light passing through one 

would be blocked by the other. The liquid crystal twists the polarization of light entering one filter to allow it to 

pass through the other.  

                       A program must interact with the outside world using input and output devices that communicate 

directly with a human being. One of the most common devices attached to an controller is an LCD display. 

Some of the most common LCDs connected to the contollers are 16X1, 16x2 and 20x2 displays. This means 16 

characters per line by 1 line 16 characters per line by 2 lines and 20 characters per line by 2 lines, respectively. 

           Many microcontroller devices use 'smart LCD' displays to output visual information.  LCD displays 

designed around LCD NT-C1611 module, are inexpensive, easy to use, and it is even possible to produce a 

readout using the 5X7 dots plus cursor of the display.  They have a standard ASCII set of characters and 

mathematical symbols.  For an 8-bit data bus, the display requires a +5V supply plus 10 I/O lines (RS RW D7 
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D6 D5 D4 D3 D2 D1 D0).   For a 4-bit data bus it only requires the supply lines plus 6 extra lines(RS RW D7 

D6 D5 D4). When the LCD display is not enabled, data lines are tri-state and they do not interfere with the 

operation of the microcontroller. 

Electrical block diagram: 

 

ACTIVE PASSIVE BUZZER 

 
ESP8266-01 PIN DESCRIPTION: 

 
3V3: - 3.3 V Power Pin. 

GND: - Ground Pin. 

RST: - Active Low Reset Pin. 

EN: - Active High Enable Pin. 

TX: - Serial Transmit Pin of UART. 

RX: - Serial Receive Pin of UART. 

GPIO0 & GPIO2: - General Purpose I/O Pins. These pins decide what mode (boot or normal) the module starts 

up in. It also decides whether the TX/RX pins are used for Programming the module or for serial I/O purpose. 

To program the module using UART, Connect GPIO0 to ground and GPIO2 to VCC or leave it open. To use 

UART for normal Serial I/O leave both the pins open (neither VCC nor Ground). 

SOFTWARE DESCRIPTION 

ARDUINO SOFTWARE: 

The Arduino is a family of microcontroller boards to simplify electronic design, prototyping and experimenting 

for artists, hackers, hobbyists, but also many professionals. People use it as brains for their robots, to build new 

digital music instruments, or to build a system that lets your house plants tweet you when they’re dry. Arduinos 
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(we use the standard Arduino Uno) are built around an ATmega microcontroller — essentially a complete 

computer with CPU, RAM, Flash memory, and input/output 

What you will need: 

 A computer (Windows, Mac, or Linux) 

 An Arduino-compatible microcontroller (anything from this guide should work) 

 A USB A-to-B cable, or another appropriate way to connect your Arduino-compatible microcontroller to 

your computer (check out this USB buying guide if you’re not sure which cable to get). 

 

 

 

 

 

 

 

LAUNCH AND BLINK! 

After following the appropriate steps for your software install, we are now ready to test your first 

program with your Arduino board! 

 Launch the Arduino application 

 If you disconnected your board, plug it back in 

 Open the Blink example sketch by going to: File > Examples > 1.Basics > Blink 

 
 Select the type of Arduino board you’re using: Tools > Board > your board type 

 
 Select the serial/COM port that your Arduino is attached to: Tools > Port > COMxx 
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If you’re not sure which serial device is your Arduino, take a look at the available ports, then unplug your 

Arduino and look again. The one that disappeared is your Arduino. 

With your Arduino board connected, and the Blink sketch open, press the ‘Upload’ button 

After a second, you should see some LEDs flashing on your Arduino, followed by the message ‘Done 

Uploading’ in the status bar of the Blink sketch. 

If everything worked, the onboard LED on your Arduino should now be blinking! You just programmed your 

first Arduino! 

APPLICATION 

• Real time power monitoring of any system (like Domestic and industrial loads)  

• System is incorporated with all kind of users  

• Idea is well suited for energy theft properly, especially for rural and city areas  

• It is also possible to implement in school and colleges for power monitoring purpose  

• It is easy to analyze the amount of energy theft in system or in Area 

 

CONCLUSION  

In this paper, Energy theft monitoring using IoT is an innovative application of internet of things developed to 

control the power theft remotely over the cloud from anywhere in the world. In the proposed project particle 

photon module used for monitoring purpose. The system updates the information in every 10 to 12 seconds on 

the Think Speak cloud using internet. This system is basically made for the reduce the Electricity theft (or 

pilferage) issue to reduce the commercial losses, direct hooking on power line this issues can be also eliminated 

by using this system 
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